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How	to	create	an	annual	report	in	indesign.	Is	there	a	free	version	of	adobe	indesign.

When	it	comes	to	your	annual	report	design,	you'll	want	to	present	your	year	in	the	most	professional	way	possible.	A	clean,	well-designed	annual	report	is	a	sure-fire	way	to	do	so.	A	professionally	designed	annual	report	template	often	includes	all	kinds	of	layout	options	too—plenty	to	work	with	an	adapt!		A	sleek,	professional	annual	report	template
could	help	bring	that	style,	class,	and	prestige	to	your	work	and	your	data.	Use	one	for	your	next	annual	report	to	both	impress	and	simplify	the	process!	Imagine	going	to	a	professional	meeting	without	looking	your	sharpest.	You	wouldn't	do	that.	Why	treat	your	annual	report	any	differently?		The	perfect,	professional	impression	means	visually
communicating	trust,	reliability,	and	dependability.	We	want	our	audience,	our	clients,	and	our	peers	to	feel	this	professional	confidence	when	accessing	our	content.	Doing	so	is	easier	than	ever	with	an	annual	report	template	from	Envato	Elements.	The	professional	annual	report	designs	from	GraphicRiver	are	also	great	choices.	Best	Annual	Report
Templates	on	Envato	Elements	(With	Unlimited	Use)	Why	an	annual	report	template?	They're	easy	to	use,	typically	simple	to	customize,	and	can	often	save	you	a	lot	of	time	and	resources.	Let's	say	you	know	what	you	want,	you	just	need	a	little	extra	help.	A	template	might	not	only	fit	the	bill,	but	it	might	also	be	adaptable	to	other	project	needs,	too!
Envato	Elements	can	be	an	excellent	choice	for	your	design	needs.	Not	only	can	you	find	a	wealth	of	annual	report	templates—there's	graphics,	backgrounds,	audio,	mock	ups,	and	so	much	more!	But	wait,	the	best	part	is,	you	get	access	to	thousands	of	assets	for	one,	low	fee.		You	can	find	hundreds	of	templates,	assets,	annual	report	theme	examples
and	more	on	Envato	Elements!	The	annual	report	design	templates	in	this	article	are	clean,	professional,	and	easy	to	customize.	Need	to	change	the	colors?	Want	to	further	customize	how	your	branding	is	represented?	Go	for	it.		These	annual	report	themes	can	be	just	the	springboard	you	need	to	meet	your	goals,	both	quickly	and	at	an	awesome
price.	Annual	report	format	matters	too.	So,	think	about	the	software	environment	and	delivery	method	that	best	suits	your	needs.	A	good	annual	report	has	a	clean,	professional	design,	like	this	beautiful	and	versatile	design,	available	now!	It's	as	simple	as	downloading	the	annual	report	layout,	opening	it	up	in	the	applicable	software,	and	making
your	edits!	With	Envato	Elements,	you	also	have	the	luxury	of	downloading	many	annual	report	templates	and	companion	assets	too.	So,	you	can	experiment,	test,	and	combine	to	your	heart's	content.	5	Annual	Report	Templates	From	Envato	Elements	for	2022	Let's	look	at	some	top	annual	report	designs	from	Envato	Elements—they're	some	of	the
best	annual	report	designs	2022	has	to	offer!	Add	them	to	your	collection	of	design	assets	for	professional	use.	Or	check	out	these	annual	report	design	samples	for	visual	inspiration:	1.	Annual	Report	Template	See	more	of	this	annual	report	theme	examples	from	the	image	gallery	above.	Here's	a	summary	annual	report	template	that	looks	perfect	for
all	types	of	organizations.	It's	an	annual	report	design	with	modern	design	that	stands	up	to	2022	in	style.		Download	this	annual	report	template	to	get	24	pages	that	you	can	customize.	That	includes	image	placeholders,	paragraph	styles,	and	infographics.	This	annual	report	layout	design	also	comes	with	free	fonts.	2.	Blue	Annual	Report	Template
Design	With	twenty	unique	pages	to	choose	from,	this	annual	report	design	offers	so	much	to	work	with!	Not	only	that,	but	these	versatile	annual	report	layout	designs	could	be	adapted	to	work	for	other	projects	too!	Use	it	if	you're	looking	to	spice	up	your	annual	report	design	with	2022	inspiration.	3.	InDesign	Annual	Report	Design	This	design
could	be	a	great	fit	if	you've	got	some	photos	in	mind	for	your	annual	report.	It	comes	with	a	front	and	back	cover,	as	well	as	thirty-four	pages—there's	so	much	to	see	and	work	with	here!	It's	not	a	bad	choice	for	a	summary	annual	report	template.	4.	Clean	and	Creative	Annual	Report	Layout	Looking	for	something	bold?	This	design	has	really	playful
pops	of	color	that	could	make	such	a	memorable	impression!	Or	maybe	you	could	adapt	this	summary	annual	report	template	to	work	with	your	signature	colors!	It	comes	in	both	A4	and	US	letter	sizes,	with	32	different	pages.	5.	Stylish	Geometric	Annual	Report	Layout	Design	This	template	has	so	many	possibilities.	Swap	out	the	colors	and	the	logo
with	your	branding	and	guidelines.	Keep	in	mind	that	the	dates	here	are	entirely	variable	and	up	to	you!	Change	it,	adapt	it,	and	even	use	it	for	more	than	one	year!	This	download	of	an	annual	report	template	is	versatile	enough	to	last	a	while.	Envato	Elements	(Design	Without	Limits)	Remember,	we're	talking	about	one,	low	price	here	for	hundreds
of	annual	report	templates.	Download	as	many	as	you	like.	There's	so	many	annual	report	templates	to	choose	from!	Take	a	peek!When	you	sign	up	for	Envato	Elements,	you	get	access	to	all	the	content	your	project	needs—from	annual	report	templates,	to	fonts,	graphics,	and	more!	There's	thousands	of	assets,	all	with	unlimited	use,	and	it's	all	for
one	low	price.Get	Unlimited	Downloads	for	all	your	template	needs—and	more!	Think	about	it.	You'll	have	thousands	of	beautiful,	professionally	designed	assets	and	templates	at	your	fingertips.	All	of	them	can	be	used	for	your	professional	ventures.	Handy,	right?	20	Top	Annual	Report	Templates	from	GraphicRiver	for	2022	(For	One	Time	Purchase)
But	let's	say	you	prefer	a	single	purchase—as	opposed	to	unlimited	access	to	a	large	and	growing	library	of	templates	and	assets.	Envato	Elements	is	a	great	deal,	but	sometimes	you	know	exactly	what	you	want,	and	that's	all	you	want.	In	that	case,	check	out	GraphicRiver	for	your	next	template	of	an	annual	report.		GraphicRiver	has	an	impressive
host	of	creative	content	to	download,	including	summary	annual	report	templates.	There's	hundreds	of	templates	with	good	annual	report	designs	available	on	GraphicRiver,	as	a	one	time,	single	purchase.	There's	a	lot	to	see	here,	so	I	like	to	go	through	and	bookmark	my	favorites!	It's	great	source	of	inspiration	as	you	decide	on	the	direction	for	your
own	annual	report.	15	Top	Annual	Report	Templates	from	GraphicRiver	for	2022	(for	One	Time	Purchase)	Let's	look	at	some	of	the	lovely	designs	available	on	GraphicRiver,	as	well	as	what	makes	a	great	design	tick!	Pick	up	some	annual	report	layout	design	insight	from	these	annual	report	design	samples.	Think	about	what's	most	important	in	your
design	decisions.	1.	Modern	Annual	Report	Design	Our	list	of	the	best	annual	report	theme	examples	from	GraphicRiver	starts	off	here.	This	modern	download	is	perfect	for	2022	and	beyond,	and	comes	with	32	A4	and	US	Letter	pages.		There	are	unique	paragraph,	object,	and	character	styles	available	to	tweak	your	annual	report	layout.	Combined
with	the	image	placeholders,	customizing	this	report	design	is	a	breeze.	2.	Blue	Annual	Report	Template	This	annual	report	design	skips	the	rounded	shapes	for	a	traditional,	corporate	look.	But	don't	let	that	put	you	off	of	this	option!	When	you	download	this	annual	report	template,	you're	also	getting	a	layout	that's	engaging	and	interesting	to
behold.	Head	to	the	item	page	to	take	a	closer	look	at	the	36	pages	of	this	annual	report	design.	3.	Contemporary	Annual	Report	Design	Template	Layout	Do	you	need	an	annual	report	design	that	blends	your	text	and	visual	content	well?	Then	a	template	like	this	one	is	for	you.	Just	about	every	page	merges	text	and	images,	charts,	and	graphics
seamlessly.	This	download	is	also	print	ready,	so	you	can	have	a	good	annual	report	design	ready	to	go	in	a	handful	of	clicks.	4.	Horizontal	Annual	Report	Here's	a	good	annual	report	layout	design	with	a	different	perspective.	This	template	features	well-designed	horizontal	pages.	There	are	28	pages	included	in	both	A4	and	US	Letter	size.	Take
advantage	of	the	modern	look	to	make	the	best	annual	report	design	for	your	organization.	5.	Yellow	Annual	Report	Theme	Example	Stay	professional	with	this	annual	financial	report	design.	Each	page	leaves	plenty	of	room	for	your	content,	but	there	are	nice	layout	touches,	too.	Place	your	photos	within	the	custom	image	masks	and	edit	titles	with
modern	fonts.	If	you've	got	Adobe	InDesign	or	Affinity	Designer,	try	out	this	annual	report	layout	design	template.	6.	Summary	Annual	Report	Brochure	Template	If	you	need	a	professional	annual	financial	report	design	layout,	try	out	this	template.	It	uses	a	modern	blue	color	theme	to	complement	its	design	and	your	content.	Take	advantage	of
helpful	features	like:	automatic	page	numbering	well-organized	layers	editable	colors	links	to	free	fonts	With	its	sharp	looks,	you	won't	need	much	annual	report	design	inspiration	to	finish	your	project	with	this	template.	7.	Annual	Report	InDesign	Template	This	template	of	a	good	annual	report	design	has	such	a	fun	pop	of	color.	We	get	a	lot	of
playful	variation	here	in	the	annual	report	layout	design	options,	as	well!	While	we	get	a	lot	to	work	with,	in	this	template,	it's	also	great	note	how	visual	consistency	is	established	here,	too.	The	use	of	limited	color	helps	pull	this	together	in	a	unified	way.	8.	Annual	Report	Template	Design	This	is	one	of	the	best	annual	report	designs	you	can	use	with
a	minimalist	design.	Note	all	the	negative	space	(or	open	spaces)	in	this	annual	report	design.	There's	a	reason	why	this	approach	is	so	popular	in	annual	report	themes—it's	because	it	looks	great	and	is	very	versatile.		9.	Professional	Annual	Report	Template	Isn't	this	a	striking	annual	report	cover	design?	It's	versatile	too—this	one	could	work
for	financial	report	design	and	other	business	projects	too.	The	best	annual	report	design	is	the	one	that	meets	your	goals—but	imagine	if	it	was	versatile	enough	to	work	for	other	parts	of	your	business	needs	too!	10.	Annual	Report	Layout	InDesign	This	template	is	a	great	example	of	emphasis	in	action.	Notice	how	the	red	here	really	commands	our
attention.	That's	because	variety	stands	out!	We	can	use	this	premise	to	our	advantage,	as	shown	here.	When	you	add	in	your	content,	this	good	annual	report	design	becomes	a	great	communication	tool	for	your	organization.	11.	Stylish	Annual	Report	Template	Design	Remember	what	we	discussed	about	color?	Not	only	can	it	be	used	as	a	unifying
element,	but	it	can	be	used	to	create	points	of	emphasis	too!	This	template	is	such	a	great	example	of	strong	annual	report	layout	design	decisions—and	there's	even	more	layouts	to	choose	from!	12.	Annual	Report	Design	Layout	Isn't	this	annual	report	graphic	design	approach	visually	interesting?	There	are	so	many	creative	annual	report	designs	out
there.	When	it	comes	time	to	choose	from	all	the	annual	report	themes	keep	your	objectives	in	mind.	Visuals	are	communicative.	So,	you	want	something	professional	that	also	resonates	with	your	project's	goals.	13.	Annual	Report	Templates	Black	and	white,	as	a	color	scheme,	can	be	such	a	classy,	timeless	aesthetic.	Do	you	see	any	of	the	annual
report	layout	design	principles	we	mentioned	in	action	here?		Note	how	orderly	the	content	is.	Shared	margins	and	other	in	common	visuals	can	help	promote	visual	unity,	like	we	see	in	this	template!	Minimalist	annual	report	design	can	be	such	a	strong	approach.	14.	Colorful	Annual	Report	Design	Layout	Visual	associations	don't	always	necessarily
have	to	rely	on	a	square	grid	like	we	see	in	this	playful	template.	Swap	the	colors,	add	your	images,	and	this	template	could	work	in	a	variety	of	situations.	It's	such	a	fun	download	of	an	annual	report	template.	It	definitely	one	of	the	most	creative	annual	report	designs	on	this	list!	15.	Annual	Report	InDesign	Template	Speaking	of	which,	check	out
this	design!	How	fun	is	this	annual	report	cover	design?	Don't	be	afraid	to	have	a	little	fun	with	your	annual	report	layout	design—it	should	reflect	the	personality	of	your	organization!	If	there's	room	for	smiles,	maybe	you	can	sneak	a	few	in	there!	16.	Annual	Report	Layout	Design	Whether	you're	looking	for	creative	annual	report	designs	or	the	best
annual	reports	2022	has	to	offer,	versatility	is	often	key.	Remember,	the	best	annual	report	design	is	the	one	that	communicates	clearly	and	leaves	a	lasting	impact—both	in	form	and	function.	A	summary	annual	report	template,	like	this	one,	can	be	adapted	to	fit	a	variety	of	disciplines.	Customize	it	to	meet	your	objectives.	17.	Annual	Report	Square
Brochure	Template	Next	on	our	list	of	annual	report	themes	is	this	minimal	option.	Its	compact	square	shape	is	unique	for	this	template	category.	Add	photos	to	most	pages	for	a	great	visual	element.	It's	one	of	the	best	annual	report	templates	for	your	creative	or	finance	agency.		18.	Stylish	Annual	Report	Layout	Template	Sometimes	the	best	annual
report	designs	are	the	ones	that	take	risks.	This	summary	annual	report	template	is	a	perfect	example.	It	decides	against	a	straight-laced	corporate	layout	in	favor	of	a	stylish	look.	There	are	abstract	decorative	elements	and	fun	typography	all	over	this	annual	report	design.	It's	a	top	option	if	you're	looking	at	annual	report	theme	examples.				19.
Colorful	Annual	Report	Layout	Template	If	you	want	the	best	annual	report	design,	get	a	template	like	this	one.	It	makes	great	layout	design	choices	that	are	perfect	for	2022.	It	also	uses	great	colors,	although	those	can	be	changed	to	fit	your	branding.	This	download	of	an	annual	report	template	gives	you	24	pages	that	you'll	be	proud	to	show	off	to
stakeholders.	20.	Professional	Annual	Report	Template	This	20	page	download	closes	out	our	list	of	annual	report	theme	examples.	It	comes	with	easy-to-edit	infographics,	image	placeholders,	and	more	in	its	layouts.	This	download	also	has	a	unique	annual	report	cover	design.	Overall	it's	a	top	choice	if	you	want	to	freshen	up	your	annual	reports	with
modern	design	inspiration.	How	to	Customize	an	InDesign	Annual	Report	Template	So,	you've	found	the	perfect	annual	report	design.	Now	what?	Let's	talk	about	how	to	customize	your	new	annual	report	layout	design.	There	are	many	annual	report	formats	you	could	choose	from,	both	from	the	perspective	of	software	and	final	delivery.	In	this
scenario,	we'll	look	at	Adobe	InDesign—a	popular	choice	for	creative	annual	report	designs.	Use	these	quick	tips	to	help	you	jump	right	in	and	get	started	today.	We'll	use	this	annual	report	template	from	Envato	Elements	in	this	demonstration.	Feel	free	to	download	it	and	work	along	with	this	walk	through.	Or	use	a	different	InDesign	annual	report
template	of	your	choice.	This	annual	report	template	and	many	others	are	available	for	download	on	Envato	Elements.	When,	looking	at	Adobe	InDesign,	you'll	likely	come	across	these	file	types:	INDD	files,	which	is	an	InDesign	Document	file	IDML	files,	which	refers	to	InDesign	Markup	Language	file	INDT	files,	which	refers	to	an	InDesign	Template
file	INDD	files	are	your	standard,	"normal"	InDesign	files.	When	you	work	in	InDesign	and	save	your	work,	by	default,	you'll	normally	save	as	an	INDD.	If	you're	working	in	a	current	version	of	Adobe	InDesign,	an	INDD	file	would	work	just	fine.	Open	it	up	and	edit	the	document	to	your	liking.	An	IDML	file	would	be	appropriate	if	you're	working	in	an
older	version	of	Adobe	InDesign.	Affinity	Publisher	can	also	open	and	use	IDML	files.	So,	think	of	them	as	a	more	compatible	friendly	file	type.		INDT	files	are	InDesign	Template	files—meaning	you	can	open	a	new	document	based	on	this	template.	This	is	handy	if	you	want	to	preserve	a	copy	of	your	template,	untouched.		INDD	files	are	recommended.
They're	typically	the	primary	file	included	when	downloading	an	InDesign	annual	report	template.	Note	that	you	can	also	Save	As	to	create	an	IDML	or	INDT	file	from	an	INDD	file.	You've	got	options!	Simply	double	click	on	your	INDD	file	and	it'll	open	in	Adobe	InDesign.	Or	go	to	File	>	Open,	within	the	software,	and	choose	the	file	from	your
computer.		When	you	open	up	your	InDesign	annual	report	layout	design	chances	are	you	might	see	a	bunch	of	lines	all	over	your	document.	What's	up	with	that?	Well,	those	lines	are	called	Guides—and	they	won't	print	in	your	final,	completed	document.	Think	of	them	exactly	like	their	name	would	imply.	They're	visual	guides,	designed	to	help	you
align	and	adjust	content	in	your	layout.		If	you	find	them	visually	distracting,	go	to	View	>	Grids	&	Guides	>	Hide	Guides.	This	doesn't	delete	them—it	just	temporarily	hides	them	from	view.		Here's	a	preview	of	what	the	same	document	looks	like	with	the	guides	hidden.	We	still	see	boxes	around	some	of	our	content—think	of	these	like	containers.
They,	too,	can	be	hidden	(go	to	View	>	Overprint	Preview	to	check	it	out).		You	can	make	your	Guides	visible	once	again	by	going	to	View	>	Grids	&	Guides	>	Show	Guides,	located	in	the	same	place.	Now,	let's	add	some	text	to	our	annual	report	template.	Select	the	Type	Tool,	as	highlighted	in	the	example	below.	Then,	click	on	any	existing	text	box,
and	begin	typing,	as	you'd	do	in	typical	word	processing	software.	It's	that	easy!	If	you'd	like	to	add	new	text,	rather	than	editing	existing	text	in	your	template,	simply	click	and	drag	with	the	Type	Tool	selected	to	create	a	new	text	box.	Then,	click	to	start	typing.	Next,	let's	try	adding	an	image	to	our	template.	In	this	example,	the	template	has	many
blank	rectangles—these	are	placeholder	rectangular	frames	for	our	content.		With	the	Selection	Tool	active,	click	on	any	of	these	existing	placeholders.		Then	go	to	File	>	Place.	Select	your	image	on	your	computer,	and	then	InDesign	will	insert	it	into	the	rectangular	frame.	Want	to	add	an	image	elsewhere,	without	an	existing	placeholder?	You	can
still	go	to	File	>	Place.	Click	and	drag	to	create	a	new	rectangular	frame	to	hold	your	image.	Or	single	click	and	InDesign	will	insert	your	entire	image.	Sample	stock	photo	by	seventyfourimages	on	Envato	Elements.	But	what	about	saving	your	annual	report	design?	Let's	talk	about	your	options:	File	>	Save	saves	your	existing	work.	This	also	means
it'll	potentially	overwrite	the	file	you've	got	open	(particularly	if	you're	working	with	an	INDD	file).	Be	cautious	of	this!	File	>	Save	As	allows	you	to	save	a	copy	of	your	work	and/or	save	your	work	as	a	different	file	type.	You	can	find	similar	options	under	File	>	Save	a	Copy,	which	will	prompt	you	for	a	new	file	name.	File	>	Export	lets	you	export	your
work	as	a	variety	of	other	file	types,	such	as	EPUB	and	PDF,	appropriate	for	sharing,	distribution,	and	printing.	It's	important	to	note	that	your	InDesign	document	files	(such	as	INDD)	aren't	necessarily	the	files	you'll	want	to	share	with	your	audience.	Think	of	your	INDD	as	your	"behind	the	scenes	file"—where	your	PDF	(or	other	final	export)	is	more
like	the	polished	and	printed	version.	So,	how	do	we	identify,	change,	or	create	a	really	good	annual	report	design?	What	are	some	of	the	qualities	of	the	best	report	templates?	Take	a	look	at	these	annual	report	design	inspiration	tips.	1.	Presenting	the	Best	Annual	Report	Cover	Design	Think	about	the	last	time	you	went	to	a	bookstore,	or	you	took	a
look	at	the	offerings	at	a	magazine	stand.	The	cover	of	a	publication	not	only	grabs	our	attention—it's	our	opener,	but	it's	also	our	initial	statement.	And	it's	our	best	foot	forward.	Annual	report	designs	have	similar	considerations.	Make	sure	your	annual	report	cover	design	reinforces	your	brand's	goals	and	mission	statement.	Follow	your	brand



guidelines.	But	keep	these	tips	in	mind	as	well	for	a	cover	that	makes	the	right	impression.	They'll	help	you	craft	the	best	annual	report	cover	design.	Less	is	often	more.	It's	often	a	strong	idea	not	to	overwhelm	the	cover	with	too	much	information,	whether	it's	textual	or	visual.	Think	about	your	focal	point.	The	focal	point	is	the	star	of	your	show.	All
other	elements	should	reinforce	and	support	it—not	compete	with	it.	Remember	your	target	audience.	What	do	they	need	to	see	on	the	annual	report	cover	design?	What	are	their	preconceived	ideas?	Keep	them	in	mind,	when	making	design	decisions.	Sometimes,	less	is	more!	Consider	a	sleek,	clean	aesthetic	with	this	professional	design	template.
So,	the	interior	of	our	annual	report	likely	includes	a	variety	of	layout	designs.	What	makes	a	great	layout	design?	This	is	something	we	need	to	address,	whether	we're	altering	a	pre-existing	design	or	making	one	of	our	own.		First,	keep	mind	legibility	and	readability.		Legibility	refers	to	whether	the	words	themselves	are	easy	for	the	viewer	to	read.
Choose	fonts	that	are	attractive,	but	without	sacrificing	the	ability	to	clearly	and	easily	read	what's	being	said.	Readability	is	related,	but	a	little	different.	Be	mindful	of	your	sentences	and	paragraphs.	For	example,	is	the	font	large	enough	to	read	your	content	comfortably?	Is	the	paragraph	visually	fluid,	or	are	sentences	broken	up	in	a	disjointed
way?	Keep	your	content	clear	and	easy	to	read	like	in	this	annual	report	design.	Check	it	out	on	Envato	Elements!	Much	like	the	annual	report	cover	design,	keep	in	mind	that	layouts	should	be	easy	for	the	eyes	to	navigate.	When	in	doubt,	less	is	more.	There's	no	need	to	cram	a	lot	of	information	in	a	small	space.		Consider	how	the	eyes	move	through
the	layout.	We	can	guide	the	viewer	through	the	composition	using	annual	report	layout	design	principles	like	Scale.	For	example,	headers	and	titles	are	often	larger	to	command	the	viewer's	attention	first.	Subtitles	are	often	smaller	as	they're	typically	meant	to	come	second.	Notice	how	the	large,	bold	"Hi!"	commands	our	attention;	annual	report
design	available	on	Envato	Elements!	A	great	design	is	about	more	than	working	well—it	also	has	to	look	great!	We	don't	want	our	work	to	be	visually	boring.	Interesting	visuals	are	engaging	and	can	further	hold	our	viewer's	interest.	For	example,	your	annual	report	front	page	design	should	potentially	vary	from	other	parts	of	the	interior.		So,	how
do	we	add	visual	interest	to	our	annual	report	design?	Keep	in	mind	that	not	every	page	has	to	be	same.		Consider	different	visuals.	Different	pages	can	incorporate	different	layouts.	The	same	layout,	over	and	over,	can	feel	repetitive.	Mix	it	up	with	creative	design	solutions	that	work	within	your	aesthetic.	Check	out	these	beautiful,	varied	annual
report	layout	designs,	available	on	Envato	Elements.	Consistency	is	very	important.	Think	of	it	as	you'd	think	of	your	professional	branding.	We	wouldn't	change	our	logo's	colors	for	the	sake	of	visual	interest—not	outside	of	our	branding	guidelines.	Variation	should	be	strategic	and	within	the	objectives	of	your	professional	goals.		Find	a	comfortable
balance	between	consistency	and	variety.	Think	of	it	like	seasoning	a	well-cooked	meal	just	right!	Follow	your	brand's	aesthetic	guidelines	in	your	annual	report	design,	but	keep	things	interesting!	Want	to	make	your	annual	report	trendy?	Or	just	looking	for	design	ideas?	Here	are	some	of	the	best	annual	report	design	trends	to	try:	1.	Make	It
Colorful	Make	your	annual	report	design	colorful.	Make	your	annual	report	design	fun	by	making	it	colorful.	A	colorful	annual	report	is	less	boring	than	a	plain	black	and	white	report.	By	adding	color,	you	keep	the	reader	more	engaged.	Color	will	also	make	your	annual	report	stand	out.		2.	Minimal	A	minimal	annual	report	layout	design	will	look
more	impressive	and	professional.	A	minimal	design	is	less	distracting	for	the	reader.	If	the	design	is	too	much	or	you	have	too	much	text	on	a	page,	it	can	overwhelm	the	reader.		3.	Geometric	Shapes	Use	geometric	shapes	in	your	annual	report	design.	Geometric	shapes	give	a	sense	of	nostalgia	to	the	reader.	Geometric	shapes	give	a	3D	look	to	your
design.	Geometric	shapes	are	simple	but	striking.	They	add	impact	to	your	design.	So,	if	you	want	to	have	an	impact	on	your	reader,	try	adding	geometric	shapes	to	your	annual	report	design.		4.	Interesting	Image	on	the	Cover	A	design	trend	is	to	have	an	annual	report	cover	design	with	an	interesting	image	on	the	cover.	You	can	use	an	image	of	from
company	files	or	a	stock	image	from	Envato	Elements.	The	right	Images	on	the	cover	can	make	your	annual	report	memorable.	5.	Dark	Background	Dark	Backgrounds	look	minimal	and	luxurious.	An	annual	report	design	trend	is	a	report	with	a	dark	background.	Dark	backgrounds	have	a	luxurious	and	minimal	design.	When	you	use	a	dark
background,	your	text	can	stand	out.	But	make	sure	that	your	text	is	a	light	color	otherwise	your	report	will	be	unreadable.			Find	Even	More	Creative	Annual	Report	Designs	Looking	for	even	more	annual	report	design	inspiration?	Check	out	these	collections	of	professional	annual	report	design	samples.	There's	plenty	more	annual	report	design	to
check	out—consider	downloading	one	today	to	add	to	your	collection	of	design	assets:	25	Best	Annual	Report	Template	Designs	-	With	Creative	InDesign	Layouts	(2022)	18	Best	Free	Annual	Report	Template	Downloads	2022	(Word	Designs	&	More)	20	Free	Annual	Corporate	Report	Templates	for	MS	Word	&	Google	Docs	2022	Where	to	Find	the	Best
Annual	Report	Themes	(Envato	Elements	vs	GraphicRiver)	No	doubt	you've	found	some	annual	report	design	samples	above	that	have	caught	your	eye.	But	you	still	might	be	wondering	whether	to	choose	your	template	from	Envato	Elements	or	GraphicRiver.	After	all,	they	both	offer	premium	annual	report	themes.	If	you	need	help	making	your
choice,	let's	look	at	the	unique	benefits	offered	by	Envato	Elements	and	GraphicRiver:	1.	Key	Benefits	of	Envato	Elements	Envato	Elements	is	an	incredible	subscription	service.	It	offers	unlimited	access	and	downloads	to	its	full	digital	asset	library.	That	means	you	can	download	as	many	product	mockups,	music	tracks,	and	more	assets	without	any
download	caps.	It's	an	unbeatable	offer.	Here	are	some	annual	report	design	samples	you	can	find	on	Envato	Elements:	Have	a	look	at	the	premium	annual	report	theme	examples	on	Envato	Elements.	GraphicRiver	is	part	of	the	Envato	Market	suite	of	online	asset	marketplaces.	Find	and	buy	individual	graphics	that	have	professional	quality.	You	can
find	the	visual	asset	you	need	to	complete	your	project	without	a	subscription.	Have	a	look	at	the	individual	annual	report	themes	available	on	GraphicRiver:	Browse	the	thousands	of	annual	report	design	samples	from	GraphicRiver.	Now	that	you	know	the	benefits	of	Envato	Elements	and	GraphicRiver,	making	the	choice	becomes	a	lot	easier.	If	you
need	an	annual	report	today	but	will	need	other	creative	assets	throughout	the	year,	choose	Envato	Elements.	It's	full	of	useful	elements	that	can	make	finishing	your	projects	easier.	Sign	up	for	Envato	Elements	now.	Design	without	limits	with	an	Envato	Elements	subscription.	Do	you	need	to	wrap	up	a	project	now?	If	you	know	you	won't	need	more
than	the	best	annual	report	for	today,	head	to	GraphicRiver.		Common	Annual	Report	Questions	Answered	(FAQ)	Is	this	your	first	time	making	an	annual	report	or	using	a	premade	financial	report	design?	If	so,	you	probably	have	questions.	From	writing	to	design,	I'll	answer	a	few	common	questions	you've	got	so	you	can	make	the	best	annual	report
in	2022:	1.	How	Do	I	Write	My	Annual	Report?	You	need	to	know	what	type	of	annual	report	you're	writing.	There	are	four	common	types:	corporate	annual	report	small	business	annual	report	nonprofit	annual	report	alternative	annual	report	With	that	being	said,	there	are	a	few	important	elements	they	share.	The	company	profile,	business
performance	overview,	and	financial	information	are	all	key.	Learn	more	about	annual	reports	from	these	tutorials:	What	Is	an	Annual	Report?	(With	Definition	&	Top	2020	Business	Examples)	How	to	Write	&	Design	a	Great	Annual	Report	for	2020	(+10	Quick	Tips)	2.	What	Software	Do	I	Need?	You'll	find	most	annual	report	themes	work	with	Adobe
Photoshop,	Illustrator,	or	InDesign.	These	are	common	design	programs.	If	you	only	have	Microsoft	Word,	don't	worry!	There	are	plenty	of	premium	financial	report	designs	that	work	with	that	program	as	well.	3.	How	Many	Pages	Should	My	Annual	Report	Be?	Many	annual	financial	report	designs	will	have	20+	pages	for	you	to	use.	But	it's
important	to	let	your	content	dictate	the	length.	If	you	need	more	pages,	feel	free	to	duplicate	and	rearrange	layouts	to	suit	your	needs.	4.	What	Colors	Should	I	Use	in	My	Annual	Report	Template?	I	recommend	using	your	brand's	colors	for	your	annual	report.	Since	the	information	inside	is	purely	about	your	organization,	it's	a	good	idea	to	align	the
look	of	your	report	to	your	brand.	If	you	do	choose	to	try	other	colors,	use	this	color	wheel	from	Adobe	to	find	tones	that	complement	your	branding.	Use	the	color	wheel	from	Adobe	to	find	color	options	for	your	annual	report	template.	Even	though	it	features	a	lot	of	data	and	technical	information,	you	still	need	to	write	to	engage.	Your	annual	report
is	a	place	to	showcase	your	organization's	performance	over	the	last	twelve	months.	Use	it	as	an	opportunity	to	motivate	shareholders,	customers,	and	staff.	Learn	how	to	add	background	images	to	Word	documents	in	the	tutorial	below:	How	to	Quickly	Add	&	Edit	Great	Background	Images	in	Microsoft	Word	Learn	More	About	Annual	Report	Design
Your	annual	report	is	an	important	part	of	your	professional	work,	your	business,	and	your	year.	It's	important	to	put	your	best	foot	forward.	Clearly,	that's	easier	said	than	done.		There's	plenty	to	explore	here.	Thankfully,	there	are	also	plenty	of	resources	out	there	to	help	you	arm	yourself	with	the	knowledge	to	create	the	perfect	annual	report!
Here's	to	your	best	annual	report	design	ever	in	2022!	Check	out	these	tutorials,	inspirational	round	ups,	and	more!	Dazzle	Your	Audience	With	a	Professional	Annual	Report	Template!	Are	you	ready	to	create	your	next	annual	report	template	design?	You	can	find	plenty	of	the	best	annual	report	designs	on	Envato	Elements.	Or,	if	you	only	need	a
single	template	of	an	annual	report,	download	it	from	GraphicRiver.	Why	not	get	started	today?	And	here's	hoping	your	next	annual	report	is	your	best	ever!	Editorial	Note:	This	post	has	been	updated	with	contributions	from	Sarah	Joy	and	Nathan	Umoh.	Sarah	is	a	freelance	instructor	for	Envato	Tuts+.	Nathan	is	a	staff	writer	with	Envato	Tuts+.
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